
 

  
  

      
  
  
  

  
  

noname2
You have downloaded the DEMO version of these tutorials and have the author's permission to distribute this demo freely.  While the full table of contents is shown, only three tutorials are included.Included in this DEMO:CREATING TEMPLATESCREATING A MAIL MERGEWORD SHORTCUTSIf you like this demo, a low-priced full version can be purchased at:Karyn's Toolkit:  http://tutorials.esmartweb.com/collection.htm

noname2
You have downloaded the DEMO version of these tutorials and have the 
author's permission to distribute this demo freely. While the full table of 
contents is shown, only three tutorials are included.



The material contained in this set of tutorials is copyrighted and is not to be 
distributed without the permission of the author.  Users have permission to print for 
personal use only.  Contact the author at the email address provided below if you are 
interested in distributing or using this material other than for personal use. 
  
About the author… 
 
Karyn Stille is an educator, software trainer, and Web site designer.  In 1988, she 
obtained her Bachelor of Science degree in Education from Iowa State University.  
From there she headed south to Texas and taught in the public school system for 
nine years.  While in the public school system, she saw a real need to educate not 
only children, but also adults on how to use the computer.  Knowing the advantages 
of using the computer to make her life and work more efficient, coupled with her 
knowledge of computers, software and experience in education led her into corporate 
software training. 
 
For the next four years, Karyn taught hundreds of executives and employees how to 
use Microsoft Office and other software products.  Not only did she teach, but also 
tried her hand at technical writing and documentation of software procedures for 
clients.  Eventually, she developed the desire to share her knowledge via the 
Internet, which enabled her to reach thousands more than she could ever reach in 
her current position. 
 
Karyn took a contracting position and became a Guide with one of the largest 
information-based Web sites on the Net.  Her position allowed her to instruct and 
advise thousands of people on business software via both the Web site and 
newsletters.  The praise she received from site visitors and newsletter subscribers 
inspired her to write and publish this set of tutorials.  
 
Today, Karyn is a stay-at-home mother of two young children and has migrated back 
to her home in Iowa.  Her desire to stay at home and raise her family has taken her 
in yet another direction.  Karyn still writes about software, but finds the creativity 
involved in developing Web sites a nice refuge from a busy day. 
 
From Karyn: 
 
“I hope you find this set of tutorials helpful and that you acquire some new skills that 
make your work more productive.  I enjoy helping others, and welcome your 
feedback and questions.  Feel free to email me!” 
 

Karyn  
kstille@esmartweb.com
http://tutorials.esmartweb.com
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Creating Templates 
 
A template allows a user to save document formats and text in a manner that makes 
it easy to use the document repeatedly without fear of the formats and text 
changing.  Simply put, templates provide consistency, especially when multiple users 
need to use the same document format.  When a document is based on a template, 
changes made in the document are saved in the document file, but the template 
remains in its original state to be used again.   

Why not just keep changing the same document every time?  Too often a user clicks 
the Save button without remembering to save the document under a different 
name.  Once that happens, any of the original formats and text that may have been 
changed for the current document are lost. 

There are two ways to create a template in Word.  You can create a template based 
on one of the many templates already available in Word, or you can create your own 
from scratch. 

Using an Existing Template 

There are many useful pre-designed templates already available in Word that can be 
used to create a new template.  Many additional templates can also be downloaded 
free of charge from the Microsoft Website (http://www.microsoft.com). 

To base your template on an existing template:  

1. From the File menu, choose New. 

 

2. Select a template from the various tabs in the New dialog box. 
3. In the Create New field, select Template. 
4. Choose OK. 
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5. The new template opens.  Make any necessary text and formatting changes 
to the template in the same manner as you would make changes in a 
document. 

6. When you are finished making changes to suit your needs, from the File 
menu, choose Save.  You have opened a new template that awaits a name, 
so there is no need to worry about overwriting the original template with your 
new one by choosing File/Save or the Save button. 

7. The Save dialog box opens to the Templates folder.  By saving your 
template in the Templates folder, you can easily create a document based 
on your new template by finding it under the General tab in the File/New 
dialog box. 

8. Type a name for your template and choose Save. 

 

Creating a Template from Scratch  

Creating a template from scratch is easy!  In a regular blank document, insert text 
and apply formatting as you would any document.  You may want to include blank 
lines or spaces where information needs to be filled in.  You can also use form fields, 
which you may have noticed in some of the existing templates that are packaged 
with Word.  Here are some bare bones basics that can be used to create simple form 
fields in your templates: 

Using a text form field:  

1. Right-click on any existing toolbar, and choose Forms from the toolbar 
menu.  The Forms toolbar is displayed as below.  You can also choose to 
display this toolbar by selecting Toolbars and Forms from the View menu. 
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2. Place the insertion point at the location where you need to insert a field.  
Choose the Text Form Field button from the Forms toolbar.  A gray blank is 
inserted in the document.  

3. Double-click on the gray blank to choose options for your text form field.  It is 
helpful to insert default text in template form fields so the user of the 
template knows what type of data to insert in the field.  Note that the gray 
areas do not show when printed, however, text entered into the gray areas 
does.  Take a look at the following simple example: 

 

The default text, such as "[insert first name here]", was typed into the Text Form 
Field Options dialog box as shown below. 

 

At a glance, anyone that is using the sample template above can see areas that need 
to be filled in and also knows what to enter into each field. 

4. Once the document is formatted to your liking, from the File menu, choose 
Save. 

5. Choose Document Template in the Save as type field.  In Word 2000, you 
are automatically directed to the Templates folder. 

6. Type a name for your template and choose Save. 
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By saving in the Templates folder, your template appears under the 
File/New/General tab, as below.  

 

To create a document based on your template, simply be sure that Document is 
selected in the Create New field. 
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Creating a Mail Merge 
 
When sending out a specific letter to a group of people, it is sometimes easier to 
create a mail merge that automatically places addresses, names, and personal 
greetings in the letters, rather than having to manually address or retype names in 
the body of the letter.  Let's explore creating a mail merge from scratch. 

Step 1: Creating a Main Document 

1.  To start a mail merge from scratch, click the New page button in the Standard 
toolbar.  The new blank page will be the main document (letter) with which the data 
source will be merged.  The data source contains the actual names, titles, addresses, 
etc. 

2.  From the Tools menu, choose Mail Merge.  The Mail Merge Helper appears as 
shown below. 

 

3.  In step 1, choose Create and select a document type. A message box appears 
asking if you want to use the document in the active window or create a new one.  
Choose Active Window. 
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Step 2: Creating a Data Source 

1.  In the Mail Merge Helper dialog box, choose Get Data (step 2) and select 
Create Data Source.  The Create Data Source dialog box appears as in the figure 
below. 

 

2.  Add and remove field names from the Field names in header row list as 
described above.  When finished, choose OK. 

3.  Enter a filename for the data source in the save box that is displayed, and choose 
OK. 

4.  When the message box appears, choose Edit Data Source to display the first 
blank data form. 

5.  In the Data Form, as shown below, enter the records by typing information into 
the fields.  Use the Tab key to move between fields.  Choose the Add New button 
after completing a record to display a new blank record.  When finished entering 
records, choose OK. 
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Step 3: Completing the Main Document 

Completing the main document involves adding the necessary fields from your data 
source and finishing the typing of your document.  Entering standard text into this 
document is accomplished by following the same methods used to enter text into any 
other type of document.  However, Word adds a special Mail Merge toolbar to the 
top of the screen to allow you to insert the data source fields and complete the 
merge. 

Inserting Data Source Fields 

1.  Move the insertion point to the location for the first field. 

2.  Choose the Insert Merge Field button on the Mail Merge toolbar. 

3.  Select the appropriate field name from the list, as shown in the figure below. 

 

4.  Continue typing the document, inserting fields where necessary.  Be sure to 
include spaces and other punctuation in appropriate places along with the field 
names.  For example, you will want to place a comma and a space after the City 
field in an address. 

Note:  You can change the font used for a field name just like you can change the 
font for any text in the document.  To do this, select the field name and change the 
font and its attributes with either the formatting toolbar or the Format/Font dialog 
box. 
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Step 4: Merging Data with the Main Document 

Once the document is finished, you are ready to merge the data source with the 
document.  The fields will be replaced with the data from your data source.  You can 
either merge directly to the printer or merge to a file to print later.  You can also 
preview your documents.  This will allow you to make any necessary adjustments 
before actually printing or saving. 

Be sure that the main document is displayed.  The Mail Merge toolbar displays on 
the screen whenever a main document is open. 

Choose the View Merged Data button to preview the resulting documents on the 
screen. 

Choose the Merge to Printer button to send the resulting documents directly to the 
printer. 

Choose the Merge to New Document button to display the resulting documents in 
a single file for saving. 

 

Alternative Data Sources 

Word also allows you to use other data sources that have been created in other 
applications.  For example, you may have an Excel spreadsheet that already lists all 
of your employees and their addresses, or you may want to use the Contact list from 
Outlook. 

To do this, in step 2 of the Mail Merge Helper dialog box, as shown below, choose 
Get Data. 
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Select Open Data Source to use a file from another program such as Excel. 

Select Use Address Book to use other sources such as your Outlook Contact List. 

Once you have chosen the data source, Word creates the appropriate field names 
that can be inserted into the main document with the Mail Merge toolbar. 

In the following example, we have chosen Use Address Book to use our Contact list 
from Outlook.  The steps are displayed in the following figures. 

 

 

 

  

Note: When a data source from another application is used (like Excel), the data 
source is linked to that application.  In other words, when information is updated in 
that application, the data source is updated as well.
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Word Shortcuts 
 
Most of the keyboard shortcuts listed here are quick shortcuts Microsoft has assigned 
to common tasks.  More keyboard shortcuts for menu items can be performed using 
the [Alt] key.  Simply press and hold [Alt], press the underlined letter of the menu 
you wish to access, then press the underlined letter(s) corresponding to the menu 
task you wish to complete.  For example, the keyboard shortcut for viewing a 
document in Normal view would be, [Alt] + [V] + [N]: 

 

The first table is an extensive list of menu, keyboard, and toolbar shortcuts.  The 
second table is a list of additional actions and keyboard shortcuts that I've found 
very useful over time. 

Table 1:  Menu, Keyboard, Toolbar 

Menu Keyboard Toolbar 

File, New [Ctrl] + [N]  
File, Open [Ctrl] + [O]  
File, Close [Ctrl] + [W] 

or 
[Ctrl] + [F4] 

  

File, Save [Ctrl] + [S]  
File, Print [Ctrl] + [P]  
File, Exit [Alt] + [F4]   

File, Send To, 
Mail Recipient 

[Alt] + [F] + [D] + 
[M]  

Edit, Undo [Ctrl] + [Z]  
Edit, Redo [Ctrl] + [Y]  
Edit, Cut [Ctrl] + [X]  

Edit, Copy [Ctrl] + [C] 
or 

[Ctrl] + [Insert] 
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Menu Keyboard Toolbar 

Edit, Paste [Ctrl] + [V] 
or 

[Shift] + [Insert] 
 

Edit, Select All [Ctrl] + [A]   

Edit, Find [Ctrl] + [F]   

Edit, Replace [Ctrl] + [H]   

Format, Borders 
and Shading 

(borders) 

[Alt] + [O] + [B]  

Format, Font [Alt] + [O] + [F] + 
[F]  

Format, Font 
(size) 

[Alt] + [O] + [F] + 
[S]  

Format, Font 
(bold) 

[Ctrl] + [B] 
(toggles on and 

off) 
 

Format, Font 
(underline) 

[Ctrl] + [U] 
(toggles on and 

off) 
 

Format, Font 
(italics) 

[Ctrl] + [I] 
(toggles on and 

off) 
 

Format, Font 
(color) 

[Alt] + [O] + [F] + 
[C]  

Format, 
Paragraph 
(left align) 

[Ctrl] + [L]  

Format, 
Paragraph 

(center align) 

[Ctrl] + [E]  

Format, 
Paragraph 

(right align) 

[Ctrl] + [R]  

Format, 
Paragraph 
(justify) 

[Ctrl] + [J]  
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Menu Keyboard Toolbar 

Format, 
Paragraph 

(increase left 
indent) 

[Ctrl] + [M]  

Format, 
Paragraph 

(decrease left 
indent) 

[Ctrl] + [Shift] + 
[M]  

Format, 
Paragraph 
(single line 
spacing) 

[Ctrl] + [1]  

Format, 
Paragraph 

(double line 
spacing) 

[Ctrl] + [2]  

Format, 
Paragraph 
(1.5 line 
spacing) 

[Ctrl] + [5]  

Format, 
Columns 

[Alt] + [O] + [C]  

Insert, 
AutoText, New 

[Alt] + [F3]   

Insert, Hyperlink [Ctrl] + [K]  
Help, Microsoft 

Word Help 
[F1]  

Help, What's 
this? 

[Shift] + [F1]  
(in corner of 
dialog boxes) 

Table, Insert 
Table 

[Alt] + [I] + [T]  

Table, Insert 
Rows (above 
selected row) 

[Alt] + [A] + [I] + 
[A] 

 

Tools, Spelling 
and Grammar 

[F7]  

Tools, 
Language, 
Thesaurus 

[Shift] + [F7]   
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Menu Keyboard Toolbar 

Tools, Macro, 
Macros 

[Alt] + [F8]   

Tools, Track 
Changes 

[Ctrl] + [Shift] + 
[E] 

  

View, Document 
Map 

[Alt] + [V] + [D]  

View, Toolbars, 
Tables and 

Borders 

[Alt] + [V] + [T]  

View, Toolbars, 
Drawing 

[Alt] + [V] + [T]  

View, Zoom [Alt] + V + [Z] 
 

View, Normal [Alt] + [V] + [N]  on horizontal 
scrollbar 

View, Print 
Layout 

[Alt] + [V] + [P]  on horizontal 
scrollbar 

View, Web 
Layout 

[Alt] + [V] + [W]  on horizontal 
scrollbar 

View, Outline [Alt] + [V] + [O]  on horizontal 
scrollbar 
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Table 2:  Action, Keyboard 
 

Action Keyboard 

Select the document. Then 
use this shortcut to 
increase the font size of all 
fonts. 

[Ctrl] + [Shift] + [>] 

Select the document. Then 
use this shortcut to 
decrease the font size of all 
fonts. 

[Ctrl] + [Shift] + [<] 

File, Save as [F12] 

File, Save [Shift] + [F12] 

Insert page break [Ctrl] + [Enter] 

Increase font by 1 [Ctrl] + ] 

Decrease font by 1 [Ctrl] + [ 

Jump to extreme lower 
right of document 

[Ctrl] + [End] 

Jump to extreme upper left 
of document 

[Ctrl] + [Home] 

Show/Hide non-printing 
characters 

[Ctrl] + [Shift] + [8] OR 

on Standard toolbar 

Superscript [Ctrl] + [Shift] + [=] 

Subscript [Ctrl] + [=] 

Undo formatting [Ctrl] + [Q] 

Reset font size to default [Ctrl] + [Shift] + [P] 

Reset to default font face [Ctrl] + [Shift] + [F] 

En dash [Ctrl] and [-] 
(on numeric keypad) 

Em dash [Alt] + [Ctrl] + [-] 
(on numeric keypad) 

Minimize all applications to 
taskbar 

[Windows] + [M] 

Open Windows Explorer to 
find files 

[Windows] + [E] 

Non-breaking hyphen [Ctrl] + [ _ ] 

Non-breaking space [Ctrl] + [Shift] + [Space] 
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Action Keyboard 

Copyright symbol [Alt] + [Ctrl] + [C] 

Trademark symbol [Alt] + [Ctrl] + [T] 

Print dialog box [Ctrl] + [Shift] + [F12] 

Double underline [Ctrl] + [Shift] + [D] 

Delete a whole word at a 
time 

[Ctrl] + [Backspace] 

Move to previous page [Ctrl] + [Page Up] OR 
on vertical scrollbar 

Move to next page [Ctrl + [Page Down] OR 
on vertical scrollbar 

Select Browse Object - 
browse document by 
tables, graphics, etc. 

on vertical scrollbar 

Increase hanging indent [Ctrl] + [T] 

Decrease hanging indent [Ctrl] + [Shift] + [T] 

Selects entire table [Alt] + [5] 
(on numeric keypad 

w/Num Lock off) 

Remove all formatting [Ctrl] + [Shift] + [Z] 
(resets to defaults) 

Close all open files Press and hold [Shift] 
From the File menu, 

choose Close All 

 




